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Authors, please fill out the brief questionnaire below.   
A.  Microscopy: Does your protocol involve video microscopy, such as filming a complex dissection or microinjection technique? (Y/N)__Y____  

Can you record movies/images using your own microscope camera? (Y/N)__Y_____  

B.   Software Usage: Does your protocol include detailed, step-by-step, descriptions of software usage? (Y/N)_Y____ 

C.  Which steps of your protocol will viewers benefit most from having filmed? 2.3 (and 2.14, 2.15, 3.7, 3.8, 3.9, all provided as LM)
D.  What is the single most difficult aspect of this procedure and what do you do to ensure success? 
3.9 - Making sure the line the pigmentation profile is read along is correct is the most difficult aspect of the procedure. This line can be edited while the profile is visible, ensuring success.
E.  Will the filming need to take place in multiple locations? (Y/N) N_____ If yes, how far apart are the locations? ___________________________________________________

1. Introduction 
A. Experimental Goal: (read by voice talent at JoVE)
The overall goal of this methodology is to rapidly quantify abdominal pigmentation in the fruit fly Drosophila melanogaster. (Intro)
B.  Required Interview Statements: (Said by you on camera. Don’t forget to smile!)  
1.1. Shingleton: This method can help answer key questions in the field of evolutionary biology, such as identifying the genetic loci that underlie inter- and intraspecific variation in morphology and understanding the development and evolution of morphological phenotypes. 
1.2. Shingleton: The main advantage of this technique is that it allows users to non-destructively measure various aspects of pigmentation, including the spread and depth of pigmentation.   
1.3. Ziabari: Though this method can provide insight into Drosophila melanogaster abdominal pigmentation it can also be applied to other Drosophila species, and easily adapted to measure pigmentation patterns in other insects and animal taxa.
Protocol: (read by voice talent at JoVE)
2. Visualizing the Specimen
2.1. Prior to imaging, the flies can be stored [1.WID] in 70% ethanol to maintain their pigmentation. [2.CU]
2.1.1. Talent gathering takes hold of storage bottle of flies for analysis
2.1.2. Detail of flies in ethanol solution in bottle
2.2. Visualization requires a mounting pad.  Load a 60-mm Petri dish with about 10 mL of 1.25% agar in water. [1.MED-TXT]  Under a microscope, use fine forceps [1.MED] to dig a 20-mm long, 2-mm wide, 1-mm deep trench into the gel.  Several trenches can be made in one dish. [3.LM]
2.2.1. Pouring molten agarose into Petri dish(es), TEXT: 60 mm x 15 mm dish
2.2.2. Talent getting situated at microscope, preparing to make trenches, takes hold of forceps and focuses scope
2.2.3. To be provided by authors, a video of the microscope’s view showing: trenches being dug into agar, show how a single trench is dug and how multiple trenches are positioned on one plate.
2.3. Then, embed a flies into the trench, [1.CU] with the surface for analysis sitting just above the gel surface.  In this case, the dorsal side is of interest.  [2.LM]
2.3.1. Talent transfers a fly from the storage bottle to the agar
2.3.2.  To be provided by authors, a video of the microscope’s view showing: implanting several flies into a trench to view their dorsal side pigmentation.
2.4. Now, fill the dish with 70% ethanol until the flies are completely submerged.  [1.CU] This reduces reflections off the cuticle that can obscure the pigmentation pattern. [2.ECU]
2.4.1. Adding ethanol to the dish, show how all the flies get completely submerged
2.4.2. Detailed view of an embedded fly before the ethanol is added with the cuticle reflecting light at camera, then the fly gets immersed in solution and the cuticle becomes visible through the solution
2.5. Now start the imaging software and digital camera connected to the microscope.  [1.MED-TEXT] For a light source, cold light from a double gooseneck device is ample. [2.MED]
2.5.1. Starting up the software, TEXT: Micro-Manager and ImageJ
2.5.2. Adjusting the lights gooseneck lighting into roughly the right postion
2.6. In the image analysis software set the image type to 8-bit.  [1.LM]
2.6.1. To be provided by authors, a screen capture showing the software being set to 8-bit capturing, TEXT: Image > Type > 8-bit
2.7. Then, in the image capture software toggle the “live” setting to open a view window of the camera.  Set the image type to gray scale. [1.LM-TXT]
2.7.1. To be provided by authors, a screen capture showing the software being put into “live” mode and the image being set to gray scale, TEXT: Contrast > Display mode > Grayscale
2.8. Now, set the light source to its maximum intensity [1.MED] and position the lights about 120 mm from stage. [2.CU]
2.8.1. Turning up the light sources power, show them getting brighter
2.8.2. Adjusting the distance of the lights to the stage
2.9. Set the microscope to 60x magnification, so the field of view is 3 mm wide.  Then, place a 2-mm stage micrometer [1.MED] into the field of view and focus on it.  [2.LM]
2.9.1. Setting the microscope to use the correct objective and then placing a micrometer on the stage, in the fov
2.9.2. To be provided by authors, a video of the microscope’s view showing: focusing on the micrometer in the fov.
2.10. Returning to the software, adjust the exposure time to view the micrometer using the field found in the “exposure” box.   [1.LM]
2.10.1. To be provided by authors, a screen capture showing adjustment of the exposure time.
2.11. Then, set the scale. Open the “straight line” tool and draw the length of two milimeters along the stage micrometer.  Then input that length under the Set Scale option. The window should then display the scale in pixels per micron. [1.LM-TXT]
2.11.1. To be provided by authors, a screen capture showing setting the scale using 2-mm length, TEXT: Analyze > Set scale > Known distance / Unit of length
2.12. Take note of the scale and “OK” the adjustments.  Now, return to the image capture software [1.MED] and use the “Stop” and “Snap” commands to capture an image of the stage micrometer. Then, return to the image analysis software and save the image as a tiff file. [2.LM]
2.12.1. Talent working at computer, takes a note and clicks the OK icon, then switches the screen to image capture software
2.12.2. To be provided by authors, a screen capture showing image of stage micrometer being taken, then returning to analysis software and saving the image, TEXT: File > Save as  > Tiff > Save
2.13. Now, focus on the dorsal midline of a mounted fly.  The midline should be positioned straight up for the best imaging results.  Push aside the wings and any other obtruding structures and adjust the lighting to best illuminate the cuticle.  [1.LM]
2.13.1. To be provided by authors, a video of the microscope’s view showing focusing on the midline, moving aside a structure that is in the way (e.g. bristle) and adjusting lighting to get best illumination
2.14. Next, set the exposure in the image capture software using the pixel value histogram as a guide to capture the full pixel range of the image without saturation, thereby maximizing contrast. Retain this exposure and lighting throughout the experiment. [1.LM]
2.14.1. To be provided by authors, a screen capture showing image showing pixel value histogram and adjustment of the image exposure to have max contrast without over-saturation
2.15. Now, before capturing an image, ensure that the abdominal segments of interest are in view. Then, capture an image and save the image with a sample ID number in the file name.  Use the format described in the written protocol.  [1.LM]
2.15.1. To be provided by authors, a screen capture showing image of specimen being taken and then saved with a sample ID style file name in a normal format
3. Image Analysis

3.1. This analysis makes use of a macro provided by the authors. [1.WID-TXT] The image series to analyze should all be contained within the same file folder. [2.LM]
3.1.1. Establishing shot of talent working at computer where image analysis is routinely performed, which might not be the one with the attached microscope, which would be nice to give this shot a change in view, TEXT: Measurement of Pigmentation.ijm
3.1.2. To be provided by authors, a screen capture showing the image series folder being opened to reveal a series of images with filenames like the one provided for 2.15.1
3.2. Now, start the macro and follow the prompted commands.  First, identify the location of the stored files.  Then, identify the location for where the analysis data should be stored. [1.LM-TXT]
3.2.1. Start_macro.mov – Screen capture movie of starting the macro, TEXT: Plugins > Macro > Run

3.3. Next, input the number of characters that were used in the filenames, so the software reads the image series correctly. [1.LM]
3.3.1. ID_characters.mov – Screen capture movie of inputing number of characters

3.4. The next prompt is for the width of the region of interest.  Here input the number of pixels along the anterior-posterior strip that need to be analyzed.  [1.LM]
3.4.1. Width_ROI.mov – Screen capture movie of inputting the width of the profile strip

3.5. Now, at the prompt, make a choice to analyze the first image of the series.  The other options are to analyze the next image in the series or to exit the analysis. [1.LM]
3.5.1. Analyze_image.mov – Screen capture movie of confirming the image to be analyzed

3.6. The line tool gets automatically selected.  Use it to identify the midline on the image by drawing a line along it in the anterior to posterior direction. [1.LM]
3.6.1. Draw_midline.mov – Screen capture movie of drawing the midline

3.7. Next, follow the macro prompts to identify the posterior edge of Tergite 4 using the line tool.  Draw a line from the posterior midline edge to the right-lateral edge such that the middle of the line, identified by a white box, is at the posterior edge of the pigment band. [1.LM]
3.7.1. Draw_posterior.mov – Screen capture movie of drawing line defining the posterior edge of the tergite. 

3.8. Then, define the anterior edge of Tergite 4 using the line tool.  Draw a line from the anterior midline edge to the right-lateral edge.  The midpoint of the line segment should sit at the anterior edge of the pigment band. [1.LM]
3.8.1. Draw_anterior.mov – Screen capture movie of drawing line defining the anterior edge of the tergite.

3.9. With this information, the macro now generates a pigmentation profile, however, the profile may be inaccurate if bristles or other blemishes cross the strip along which the profile is measured.  To correct for this, select the “live” preview on the histogram window, and adjust the line such that the profile is smooth. 
3.9.1. Adjust_strip.mov – Screen capture movie of adjusting the strip along which the profile is read. 
3.10. Ziabari: For the image analysis script to accurately capture the various aspects of pigmentation, it is vital to identify an analysis region that will have minimal noise caused by image or specimen irregularities. [MED/WID]

3.10.1. Interview at the computer with Ziabari
3.11. Now proceed to analyze Tergite 3 in the same image and then move on to the next image. [1.MED]
3.11.1. Talent using software to mark out tergite 3 and then move on to the next image
4. Results: Testing the Methodology 
4.1. The described procedure was used to explore a known change in abdominal pigmentation caused by rearing temperature.  The third and fourth tergites were examined several times under various lightings and exposures.   Various aspects of the pigmentation were explored and, specifically, it was found that the pigmentation bands were wider when flies were reared at cooler temperatures. [LM-TXT]
4.1.1. Table2, - at “it was found” add highlighting to all the bold text in the table. TEXT: Levels of Pigmentation  = Pmax and Pmin, Width of Pigment Band = Wband, Width of Tergite = Wtergite
4.2. The calculated values were then compared to general subjective measures made on the same flies by five different observers.  In the assessment of 45 female flies, the average observer ranking of the width of the fourth abdominal pigmentation band was tightly correlated with the macro’s automated measurement. [LM-TXT]
4.2.1. Supplementary Figure 1, TEXT: Spearmen’s  = 0.7342, P = 0.0001 – editor, you can remove the figure title and associated text, to just show the text I provided.
4.3. The same pigmentation band was also manually measured using imaging software.  These results were also strongly correlated with measurements generated using the macro. [LM-TXT]
4.3.1. Supplementary Figure 2, TEXT: OLS, r2 = 0.49, P < 0.0001 – editor, you can remove the figure title and associated text, to just show the text I provided.
4.4. The software was then tested to measure pigmentation in female ebony mutants which, are well known to have increased pigmentation in third and fourth pigment band. The method was also used to measure the fifth and sixth abdominal bands of wild type females. [1.LM]  The automated technique always provided useful measurements of the pigment density and band size. [2.LM]
4.4.1. Fig 4F – animate the addition of the data by first adding the leftmost four bars at “ebony in females” , then at the “The method” add the next four data bars.  The bars should grow up from the bottom of the plot when added.
4.4.2. Fig 4D – G, shrink down the 4F graph and then add three more graphs like the arrangement in Figure 4 for D to G.
Authors, please provide all of these figures as their own image files.  The should be in layered image format for easy editing, especially 4F.  Each of these four files should be listed below in the provided media section and uploaded to your project folder (see top of document).
5. Conclusion (said by authors on camera)
5.1. Shingleton: After watching this video, you should have a good understanding of how to quickly and precisely quantify abdominal pigmentation in Drosophila.  
5.2. Ziabari: Mastering the technique mostly requires the deft use of forceps. Once mastered, the imaging portion of this technique can be done at a rate of 50 specimens per hour. Extracting the pigmentation measures from these images can be done at a pace of 70 images per hour. 
Provided Media

3.2.2.
MOVIE: Start_macro.mov – Screen capture movie of starting the macro.

3.3.1.
MOVIE: ID_characters.mov – Screen capture movie of inputing number of characters

3.4.1.
MOVIE: Width_ROI.mov – Screen capture movie of inputing the width of the profile strip

3.5.1.
MOVIE: Analyze_image.mov – Screen capture movie of confirming the image to be analyzed

3.6.1.
MOVIE: Draw_midline.mov – Screen capture movie of drawing the midline

3.7.1.
MOVIE: Draw_posterior.mov – Screen capture movie of drawing line defining the posterior edge of the tergite.

3.8.1.
MOVIE: Draw_anterior.mov – Screen capture movie of drawing line defining the anterior edge of the tergite.

3.9.1.
MOVIE: Adjust_strip.mov – Screen capture movie of adjusting the strip along which the profile is read.

Several more media files are still needed.  Please provide the listed files and the others (see sections 2 to 4) and list their file names here.
General Preparation

It’s critical for a smooth and organized shoot that all reagents are accounted for, in advance.   

Any overnight or long incubation steps should be recognized and specimens/samples be prepared in advance so that prior steps can be recorded and shooting can continue with pre-prepared specimens/samples.  

All tubes/flasks should be pre-labeled neatly before we arrive.  

Ex. Luciferase assay done in 96 well plates should be labeled with negative/positive control wells and experimental samples are labeled accordingly.

You will receive more detailed preparation instructions are included in the email accompanying the finalized script.
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